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The spiral is a common pattern in nature, with Nautilus pompilius often cited as a 
prime example of the mathematical principles behind spiral growth, such as the 
“logarithmic spiral.” In plant biology, sunflower seeds are arranged in spirals that 
follow the Fibonacci sequence, optimizing space and minimizing shadowing among 
the seeds. The Fibonacci spiral and numbers are also prevalent in nature, appearing 
in the arrangement of leaves, the structure of pinecones, and the scales of 
pineapples. This pattern reflects how plants grow efficiently, maximizing space for 
each leaf and the amount of light they receive. Our study on microorganisms 
causing early blight disease in tomatoes, such as Alternaria solani, reveals that 
Fibonacci numbers frequently appear in the lesion patterns of the fungus. 
Moreover, our data show that these Fibonacci numbers approach the “golden ratio” 
(approximately 1.618), suggesting that this pattern optimizes resource allocation 
for fungal mycelial growth within plant tissue and enhances reproductive success 
of the fungus. 
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INTRODUCTION 

Tomato is one of the most agriculturally significant 

crops and is highly susceptible to fungal infections 

caused by Alternaria species. Among these, A. solani 

and A. alternata are particularly damaging, causing 

severe diseases such as early blight, attributed to A. 

solani, and brown spot, caused by A. alternata (Schmey 

et al., 2024). The symptoms of these diseases, including 

the early blight/brown spot complex, primarily 

manifest as foliar lesions that begin as brown spots. 

Depending on the species, these spots often develop 

characteristic concentric rings, eventually leading to 

severe defoliation and substantial yield losses (Schmey 

et al., 2024; Singh et al., 2014). 

Early blight lesions typically start as small, brown 

spots on tomato leaves and progressively enlarge into 

dark brown to black lesions, often displaying target-

like concentric rings on the leaf surface. These 

distinctive bullseye-like spots make early blight 

symptoms relatively easy to identify. On the affected 

leaves, A. solani produces mycelium within the plant 

tissue, while conidia form on conidiophores that 

emerge from the mycelium on the leaf surface 

(personal observation). The conidia, which are dark, 

multicellular, and septate, play a critical role in the 

spread and survival of the pathogen. 
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During infection, conidia are primarily disseminated by 

wind and rain splash. Once they land on susceptible 

plant tissue, they germinate, penetrate, and colonize the 

host tissue via mycelium, causing the characteristic 

symptoms of early blight. Effective management of 

these diseases necessitates an integrated approach, 

including the use of resistant varieties and timely 

fungicide applications. 

To date, no explanation has been provided for the 

efficiency of the harmony and the formation of the 

intricate structures and patterns observed in Alternaria 

rings on the tomato leaves. 

In nature, organisms such as the nautilus (Nautilus 

pompilius L.) and snails like Helix pomatia create shells 

composed of chambers that increase in size as the 

organism grows, enabling them to occupy the outermost 

chamber (Ward et al., 1980, 1981). Specifically, the 

nautilus expands by adding compartments of consistent 

shape, differing only in scale. This growth pattern is 

widely observed in nature. For example, the fruits of a 

pineapple are typically arranged in two interlocking 

helices. Similarly, natural phenomena such as hurricanes 

and ocean waves frequently exhibit geometric structures 

and mathematical principles, demonstrating inherent 

patterns of organization (Carson et al., 1978; Socha, 

2007; Minarova, 2014; Oosterhoff, 2018). 

In plants, phyllotaxis, the arrangement of leaves, seeds, 

or petals around a stem, often follows spiral patterns 

closely approximating the Golden Ratio, as seen in 

sunflower heads. Spiral patterns are also evident in 

structures like pinecones and pineapples, where the 

numbers of spirals adhere to Fibonacci sequences. This 

arrangement minimizes shading among leaves, ensuring 

optimal light absorption for photosynthesis. By adopting 

growth patterns aligned with the Golden Ratio, plants 

maximize efficiency, reducing the energy needed to 

produce new leaves, branches, or seeds. Such 

adaptations allow plants to thrive in competitive 

environments by optimizing resource utilization 

(Strauss et al., 2019; Jean-Paul, 2021). 

In biology, the nautilus shell is often cited as a classic 

example of the Golden Ratio due to its distinctive spiral 

form. This spiral shape is an example of a logarithmic 

spiral, also known as an equiangular spiral. In a 

logarithmic spiral, the distance between successive turns 

increases as the spiral expands outward, but the overall 

shape remains consistent. This property, known as self-

similarity, ensures that the spiral looks the same at any 

scale. The logarithmic spiral form of the nautilus shell 

enables the organism to grow without altering its shape 

(Bartlett, 2019; Kaur et al., 2021). As the nautilus 

matures, it adds progressively larger chambers to its 

shell in a precise spiral pattern, maintaining its 

proportions and structural integrity. This growth 

strategy is biologically and evolutionarily efficient, as it 

allows the nautilus to expand while preserving the 

protective structure of its shell. 

Similarly, many plants exhibit spiral arrangements in 

the organization of their leaves, seeds, or petals, often 

associated with patterns linked to the Golden Ratio. 

This arrangement optimizes sunlight exposure and 

facilitates the efficient packing of seeds in structures 

such as sunflower heads. A comparable growth pattern 

may also be present in the Alternaria fungus, which 

could maximize spore survival and germination by 

adopting efficient, stable, and reproductive strategies. 

This raises an intriguing scientific question: could the 

mathematical harmony observed in natural forms 

create target-like rings on leaf surfaces, reflecting a 

universal tendency toward efficiency and balance, even 

in pathogens like Alternaria? 

Exploring this phenomenon further could shed light on 

how such mathematical principles intersect with plant 

pathology, particularly in relation to the target-like rings 

formed on leaves during the early blight disease of 

tomatoes. By integrating mathematical models with 

biological processes, this study has the potential to 

deepen our understanding of the natural world and pave 

the way for innovative strategies to enhance plant health 

and productivity. 

 

MATERIALS AND METHODS 

Symptoms of early blight caused by A. solani 

As noted earlier, the most distinctive symptom of early 

blight is the formation of brown to dark-brown lesions 

on the leaves, often exhibiting a concentric ring pattern 

resembling a target (Figure 1). These lesions typically 

measure 1-2 cm in diameter and initially appear as 

irregular brown spots (Figure 2a) or larger brown areas 

with characteristic dark-brown rings within the lesion 

(Figure 2b). Early blight symptoms primarily develop 

on older, lower leaves before progressively moving 

upward (Figure 2c). 

The symptoms usually begin as small necrotic spots on 

the younger leaves, which gradually enlarge and can 

eventually lead to the collapse of entire leaflets. 
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According to Adhikari et al. (2017), some authors 

include A. alternata among the species responsible for 

early blight. However, unlike A. solani, A. alternata does 

not produce concentric rings on tomato leaves (Bessadat 

et al., 2021). Instead, it causes brown spot disease, which 

starts as small brown spots dispersed across the leaf 

surface (Schmey et al., 2024). 

 

 
Figure 1. Characteristic rings or target structures on 

tomato leaf caused by early leaf blight, A. solani. 

Concerning the disease cycle, A. solani reproduces 

asexually in the form of either conidia or mycelia, which 

may serve as primary sources of inoculum (Adhikari et 

al., 2017). Infection occurs during warm and humid 

conditions. Conidia germ tubes penetrate host tissue 

directly or enter through stomata or wounds, thereby 

causing infection (leaf lesions). Initially, conidiophores 

develop on the lesion and produce conidia, which are 

subsequently dispersed rapidly by wind and rain splash. 

This facilitates the continuation of the disease cycle, 

infecting healthy parts of the same plant or other plants 

(Adhikari et al., 2017). 

The early blight disease on tomato plants begins with 

the appearance of small, brownish spots on the lower 

leaves. These spots gradually grow larger and form 

concentric rings. The rings are formed by the fungus 

sporulation, which consists of abundant structures of 

conidiophores produced in the central area of the leaf 

lesion. Each conidiophore frequently produces a chain of 

conidia, which are essential for the survival and 

pathogenicity of the fungus. This biological process will 

be further elaborated and explained in detail in this 

study, including mathematical aspects. 

 

 
Figure 2. Early blight disease of tomato. Early blight spots start as irregular brown spots with characteristic rings leaf 

structure (a), and the formation of large brown spots of early blight, showing characteristic dark-brown rings within 

the lesion (b). Early blight spots start on the older, lower leaves and progressing upward (c). 

 

An example of golden ratio application in biology 

As pointed out above, the shell of H. pomatia, like many 

gastropods, follows a spiral pattern. This spiral is often a 

logarithmic spiral, similar to that seen in the nautilus 

shell. The logarithmic spiral in shells allows for 

continuous, proportional growth without changing 

a b c 
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shape, which is efficient for both protection and the 

accommodation of the snail’s growing body. 

Based on geometric structures using the Spiral of 

Theodorus (Theodorus of Cyrene (Greek: Θεόδωρος 

ὁ Κυρηναῖος, 465-398 BC), we can construct the 

snail’s body (Gautschi, 2010). In detail, as Figure 3 

shows, we start with a left-angled triangle where one 

of the legs has length 1, and the other leg has length 

√2, and contiguous left triangles, always attaching a 

new triangle with the hypotenuse of the previous 

triangle as the longer lengths equal to √3, √4, …, √7 

(Figure 3a) we use geometry for visual 

representation of the snail’s body chambers (Figure 

3b).

 

 
Figure 3. The spiral of Theodorus up to the triangle with a hypotenuse √7 (figure 3a). Using the spiral of Theodorus, 

we create the snail’s (Helix pomatia) body chambers (figure 3b). 

 

Apart from the Spiral of Theodorus, the Fibonacci 

sequence, also known as Fibonacci numbers, and the 

nautilus shell is connected through a spiral pattern 

exhibited by the shell, known as the Fibonacci spiral or 

the golden spiral (Bartlett, 2019). Mathematically, the 

Fibonacci sequence explains that the chambers in the 

nautilus shell grow in a logarithmic spiral pattern. Each 

chamber is added in a way that reflects the Fibonacci 

sequence, with the size of each chamber corresponding to 

a Fibonacci number, for example, 0, 1, 1, 2, 3, 5, 8, 13, and 

so on. These numbers play a fundamental role in number 

theory and are often encountered in algebraic 

expressions, equations, and mathematical patterns. 

Moreover, the Fibonacci sequence is closely related to the 

golden ratio (ϕ), an irrational number approximately 

equal to 1.618. Therefore, the snail body pattern (Pandey, 

2023), can be seen in the order of the Fibonacci spiral 

(Figure 4a), where each number is the sum of the two 

preceding ones, for example, 0, 1, 1, 2, 3, ... (Figure 4b and 

5a). In summary, those spiral galaxies have often been 

modeled as logarithmic spirals e.g. an arithmetic spiral 

(also known as Archimedean spiral) is a continuous curve 

that grows outward with a constant difference in radius 

or as a golden spiral that grows outward by a factor of the 

golden ratio (ϕ) with each quarter turn left as presented 

with a graph of Figure 4b. In our graph (Figure 4b), the 

golden spiral is created by connecting the corners of 

squares whose side lengths are successive Fibonacci 

numbers (1, 2, 3). This pattern, logarithmic spiral growth 

(Figure 3b), allows the organism to grow without 

changing shape Figure 4b, which is grown outward by a 

factor of the golden ratio (Pandey, 2023). 

 

 
Figure 4. A Fibonacci spiral presents the snail body 

(figure 4a and 4b). Snail shell exhibits logarithmic. 

a b 

a 

b 
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The Fibonacci sequence 

The Fibonacci sequence (Wall, 1960) is a series of 

numbers in which each number is the sum of the two 

preceding ones. It usually starts with 0 and 1. Therefore, 

the sequence is 0, 1, 1, 2, 3, 5, 8, 13, 21, 34, and so on. 

The sequence can be defined by the recurrence relation: 

F(n) = F(n−1) + F(n−2), with initial conditions: F (0) = 0, 

F (1) = 1 

So, each subsequent number in the sequence is the sum 

of the two preceding numbers. For example, to find the 

fourth Fibonacci number (F (3)), the preceding numbers 

are: 

F (3) = F (2) + F (1) = 1 + 1 = 2 

Similarly, to find the fifth Fibonacci number (F (4)), the 

preceding numbers are: 

F (4) = F (3) + F (2) = 3 + 2 = 5 

The Fibonacci sequence has numerous interesting 

properties and applications in mathematics and nature. 

Some notable aspects of mathematics include: 

Golden ratio 

The ratio of consecutive Fibonacci numbers converges to 

the golden ratio, donated by the Greek letter phi (φ), 

which is approximately equal to 1.6180339887 or (ϕ ≈ 

1.618). This ratio has aesthetic and mathematical 

significance and is often found in various aspects of art, 

architecture, and nature. 

Relationship between Fibonacci numbers and the 

golden ratio 

As we progress along the Fibonacci sequence and 

calculate the ratio of consecutive numbers (e.g., 21/13, 

34/21, 55/34, and so on), the values converge towards 

the golden ratio. In mathematical terms, if F(n) 

represents the nth Fibonacci number, the limit of 

F(n+1)/F(n) as n approaches infinity is equal to the 

golden ratio. 

Mathematically, this relationship is expressed as: 

limn→∞ F(n+1)/ F(n) = ϕi 

or φ is considered as a sequence of convergent such as: 

ϕ = (1/1, 2/1, 3/2, 5/3, 8/5, 13/8, 21/13, 34/21, 55/34 

….) 

Some notable aspects of the natural world include: 

Shell spirals 

Some seashells, such as the nautilus, exhibit spiral 

patterns that can be related to the Fibonacci sequence 

(Bartlett, 2019). 

Sunflower seed heads 

The seeds in the center of a sunflower head are arranged 

in spiral patterns, often forming two sets of spirals, one 

winding clockwise and the other counterclockwise 

(Minarova, 2014). 

Leaf arrangement and phyllotaxis 

The arrangement of leaves on a stem, known as 

phyllotaxis, often follows a spiral pattern derived from 

the Fibonacci sequence (Minarova, 2014). 

The Fibonacci spirals 

The Fibonacci spiral is closely related to the Fibonacci 

sequence and the golden ratio (Schneider, 2016). When 

we draw squares based on the Fibonacci sequence 

(Figure 5a) and connect their corners with quarter 

circles (Figure 5b), the resulting spiral approximates a 

logarithmic spiral, and the ratio of the distances between 

successive arcs converges towards the golden ratio.

 

 

Figure 5. Squares are drawn based on the Fibonacci sequence as is seen in figure a. Based on Fibonacci numbers we have 

squared patterns (figure a) of side length 1, of length 1+1=2, 1+2=3, of 2+3=5 (square at bottom edge, of side length 5 

blue line), of 3+5=8 (of side length 8 red line) and so on. The Fibonacci spiral (figure b) is a geometric pattern that 

emerges when we draw quarter circles with radii based on the Fibonacci sequence e.g. 5 (blue line) or 8 (red line). 

a b 
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Based on the above mentioned, we tested the 

hypothesis that the symptoms of the early blight 

disease of tomato are symmetrical and follow a radial 

pattern or grow with the same sequence, the Fibonacci 

sequence, and apart the shape (quantiles), the lines like 

the lengths of two-line segments (the long side and the 

short side) have the same ratio of side lengths. The 

present research work discusses and provides evidence 

for this hypothesis. 

Methodology, the study of early blight lesions, 

process calculus 

We studied leaves of tomato plants with early blight 

lesions and found a distinctive “bulls-eye” pattern of 

rings that can be seen with low magnification (20×), as 

shown in Figures 6a and 6b. Using ImageJ software 

(Vagelas et al., 2011; Vagelas, 2021), we examined 

individual lesions and converted color images to black 

and white (Figure 7). For image analysis, we utilized the 

free software ImageJ, which can be downloaded from 

https://imagej.net/ij/index.html. First, we adjusted the 

image’s color balance by selecting Image > Adjust > 

Brightness/Contrast and Image > Adjust > Color Balance 

(Figure 7a). Next, we converted the RGB image to 

grayscale by selecting Image > Type > 8-bit. After that, 

we transformed the grayscale image into black and 

white by selecting Process > Binary > Make Binary, as 

shown in Figure 7b. 

We then checked and applied a Fibonacci golden 

spiral to these images, as demonstrated in Figure 8. 

We utilized a Golden Ratio Generator (https://golden-

ratio.club/) to analyze the golden ratio in our black-

and-white images. First, we overlaid the Fibonacci 

spiral onto our images. We then used the apply 

command to fix the golden spiral overlay, as shown in 

Figures 8a, 8b, 8c, and 8d. After that, we employed the 

ruler using the ImageJ program to obtain numerical 

data (length) from the fixed Fibonacci golden spiral 

squared patterns by selecting Analyze > Measure. 

These numerical measurements were taken by 

assessing the short and long lengths, as indicated in 

Figure 5. So, for each lesion, apart from the Fibonacci 

series, we calculated the number preceding it. By 

dividing the shorter portion (short length, as 

indicated by the blue line in Figure 5b) of a line by the 

longer portion (long length, as shown by the red line 

in Figure 5a), we calculated the inverse phi (φ). This 

inverse phi (φ), also known as the Golden section, 

equals 0.61803, while the Golden Number Phi (Φ) 

equals 1.61803. The Golden Ratio, specifically the 

Golden section phi (φ), is well known to appear in 

nature, especially in botany, and represents a 

fundamental mathematical structure that is 

ubiquitous. Further, we utilized the Fibonacci golden 

spiral pattern and tested the phi (φ) hypothesis as 

shown in Table 1 on the symptomatology of tomato 

leaves, depicted in Figures 8a, b, c, and d. 

 

Figure 6.  Early blight of tomato. Early blight symptoms 

(early blight spots) start as irregular brown spots, that 

appear on tomato leaves (a) and with the formation of 

dark, concentric rings within the lesion (a, b). 

 

Figure 7. Improved image visualization (a) and converted 

image to black and white (b) using the ImageJ software. 

For image visualization we used commands Image > 

Adjust > Brightness/Contrast and Image > Adjust > Color 

Balance and for black and white we used commands 

Process > Binary > Make Binary. 

 

Statistical Analysis  

An analysis of variance was performed on all datasets 

using the JASP 0.18.3 open-source software suite 

(https://jasp-stats.org/). Further, we used Raincloud 

Plots in JASP to draw meaningful conclusions from a 

dataset presented in Figure 9. 

a b 

a b 

https://jasp-stats.org/
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Table 1. A golden relationship between the two lesion parts, the smaller- sort length (a) and the larger- long length (b)  

1st Replicate Fig.8a 2nd Replicate Fig.8b 3rd Replicate Fig.8c 4th Replicate Fig.8d 

portion (length)  portion (length  portion (length  portion (length  

a b a/b a b a/b a b a/b a b a/b 

0.7 1.2 0.583 0.6 1,2 0.692 0.8 1.4 0.571 1.1 2 0.55 

1.2 1.9 0.631 1.2 2 0.591 1.4 2.3 0.608 2 3.2 0.625 

1.9 3.1 0.612 2 3.2 0.625 2.3 3.8 0.605 3.2 5.2 0.615 

3.1 5.1 0.607 3.2 5.4 0.592 3.8 5.9 0.644 5.2 8.3 0.626 

5.1 8.1 0.629 5.4 8.9 0.606 5.9 9.7 0.608 8.3 13.6 0.610 

Mean(±S.E. mean) 0.612±0.009   0.621±0.019  0.607±0.012  0.605±0.014 

F(n) x6a = 0.629 F(n) x6b = 0.606 F(n) x6c = 0.608 F(n) x6d = 0.610 

 φ experimental = (x6a + x6b + x6c + x6d) / 4 = 0,613 

Where: a= smaller portion (sort length), b larger portion (long length) as presented by figure 5. S.E. mean= the Std Error of Mean.  

 

RESULTS 

In Figure 8, the Fibonacci Golden spiral pattern 

perfectly matches all the lesions caused by the 

Alternaria fungus on tomato leaves. In this set 

of leaves (Figure 8), the geometry of each lesion 

pattern is arranged in a spiral pattern. To be 

specific, the Golden spiral, formed by using 

quarter-circle arcs inscribed in squares derived 

from the Fibonacci sequence, fits the leaf lesion 

patterns in all figures 8a, 8b, 8c, and 8d. 

Moreover, numerical data the length ratio data 

(Table 1), obtained through the analysis of 

those spirals indicates that the φ experimental 

value is approximately 0.613 (or Phi = 1.613) 

comparable and very close to the Fibonacci 

value of (φ) of 1.618. So, data from Table 1 

supported the hypothesis that all patterns of 

Figure 8 fit the dimensions of the Golden spiral. 

Using the values from the sequence of the two 

portion lengths, where the smaller part (a) is 

divided by the larger part (b) as shown in Table 

1, we concluded that there was no statistical 

difference between the figures (p = 0.847). 

Moreover, a raincloud plot (Figure 9), illustrates 

the raw data, probability density, and summary 

statistics, including the median and quantiles. 

This plot combines individual data points, a 

violin plot, and a boxplot, and shows that these 

values are very close to the Golden Ratio, 

approximately 0.61 or φ = 1.61. The raincloud 

plot (Figure 9) highlights important aspects of 

the data. First, the raw data (Table 1) aligns with 

the central tendency. Second, both groups (refer 

to Figures 8b and 8d or Figures 8b and 8c, in the 

y-axis of Figure 9), contain an outlier that is not 

significant. Third, the data distribution (box 

plots) appears similarly compact, indicating that 

further inspection or more data are not required. 

Plotting means and F(n) values from Table 1, we 

concluded that there was no statistical difference 

between them (p = 0.765). The raincloud plot 

(Figure 10) shows that both means and F(n) 

values (Table 1) are close together, with the 

means associated with F(n) values. 

DISCUSSION 

It has been observed that the Fibonacci 

sequence and the Golden Ratio (Phi = 1.618) 

are evident in biology and nature, present in 

various organisms such as the nautilus, snails, 

pinecones, ocean waves, and hurricanes 

(Minarova, 2014; Bartlett, 2019; Turner et al., 

2023). Our study revealed that leaf symptoms 

caused by the parasitic fungus A. solani on 

plants follow the Fibonacci spiral pattern and 

the Golden Ratio (Wall, 1960), Specifically, our 

data show that plant lesions caused by the 

fungus A. solani produce a pattern similar to 

Fibonacci Rectangles spiral in a quarter turn, 

and they increase in size by a factor of Phi 

(approximately 1.618). This suggests a 

significant connection between the science of 

plant pathology and the Fibonacci sequence, 

with phenomena such as the early blight 

disease of tomatoes showing a connection of 

disease lesions to the “golden ratio”, which is 

approximately 1.618. 
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Figure 8. The Early blight disease of tomato lesions, 

fitted on the Golden Rectangle or with approximations to 

the Golden Spiral. 

 

Figure 9. The Raincloud plot provides an overview of the 

raw data, its distribution, and important statistical 

properties for two portion lengths, where the smaller 

part (a) is divided by the larger part (b), as shown in 

Table 1. 

 

Based on the data presented above, we believe that the 

Fibonacci sequence is frequently observed in nature, 

playing a significant role in the survival and dispersal of 

organisms, such as plants e.g. the distribution of 

sunflower seeds. It is well known that the arrangement 

of sunflower seeds in Fibonacci patterns can create 

optimal conditions for seed development. Based on that, 

we believe that the Alternaria plant pathogen follows a 

similar pattern for its survival and spread. These 

arrangements may enhance the efficiency of resource 

use and space occupation, which could facilitate the 

dispersal of plant pathogens. 

In nature, infectious plant diseases are mainly caused by 

fungi on leaves. They are initially characterized by small 

spots that quickly enlarge. As lesions expand, new 

lesions develop and can affect entire leaves. Some fungi 

species, such as A. solani or A. tomatophila (Gannibal et 

al., 2014), cause leaf lesions, known as leaf spot disease 

of tomato. These lesions present initially as small 

circular spots, which progress into irregular lesions with 

concentric rings later. Tomato early blight spots on 

leaves start as irregular brown spots that grow in target-

like rings around a bull’s eye of dead tissue later. Based 

on this, mathematics shows that this arrangement, like 

phyllotaxis, follows a spiral pattern that approximates 

the Golden Ratio (Wall, 1960; Turner et al., 2023). 

 

 

Figure 10. Raincloud plot, which provides an overview of 

the raw data, its distribution, and important statistical 

properties between the means and the F(n) values as 

presented in Table 1. 

 

The spiral pattern likely facilitates efficient fungus 

development on the leaf surface, contributing to the 

optimal distribution of fungus conidia. This pattern, 

following the Golden Ratio (Wall, 1960), is particularly 

important for fungus development in limited spaces, as it 

ensures structural stability and efficient conidia 

production without wasting space. We believe that this 

spiral growth pattern contributes to both the structural 

stability of the fungus and its distribution in the plant 

environment, maximizing reproductive output and the 

spread of fungus spores. Through the spiral growth 

pattern, fungus mycelia likely allocate resources, such as 

nutrients, more effectively for conidia production. 

c d 
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Stopping the Fibonacci pattern in Alternaria 

development is complex and requires a deep 

understanding of pathogen biology, growth mechanisms, 

environmental factors, genetics, and plant resistance 

factors that may influence or modify these patterns. 

Mathematics provides a framework for modeling 

complex biological processes, allowing researchers to 

predict and analyze the spread of plant diseases. By 

applying mathematical models, we can gain insights into 

the dynamics of pathogen infection, disease progression, 

and the effectiveness of control measures. Considering 

the example of Alternaria disease of this research we 

present a different application of mathematics 

combining the precision of mathematics with the 

complexity of plant pathology linked to the pathogen 

efficacy of space occupation for spread and survival. 

 

CONCLUSION 

In general, we believe that the fungus A. solani exhibits a 

spiral growth pattern similar to that of sunflowers, or H. 

pomatia body’s chambers. This pattern optimizes 

resource allocation for mycelia development within the 

plant tissue and enhances its reproductive success by 

ensuring that more conidia are produced in a confined 

space. This phenomenon serves as an example that 

highlights the profound relationship between 

mathematics and the natural world. 

In summary, the occurrence of the Golden Ratio in the 

context of the Early Blight disease of tomatoes serves 

as yet another example of mathematical patterns in 

plant pathology. 
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